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(FTLESL,

Exchange 2010 Configuration Wiza... .
Windows Server

File Share Configuration Wizard

‘e =
“§:| 1Is Configuration Wizard A
X
MSDIC Canfiguration Wizard Uhis 3
? Server Manager  PowerShell
MSMQ Configuration Wizard

Oracle Configuration Wizard g

Print Share Configuration Wizard Tk Manager™| [ Control Panel

T m

EventViewer  File Explorer

TEENLS% GUI A3zt EAYWE T, [Connect to a Host or Domain] &7V LTS,

) Veritas Enterprise Administrator

- O X
File Tools Actions Help
B =% Jac
Connect  Disconnect | Mew Window
Select Host: 3 vea//HomeAssistant/ v

Veritas Enterprise Administrator
Assistant|

Welcome to the Veritas Enterprise Administrator (VEA}. VEA allows you to connect to and manage heterogeneaus resources acrass your enterprise network.
Below s a list of tasks specific to the VEA application. Connect to a server nows by clicking the “Connect ta a Host or Domain” link below.

% Connect to a Host or Domain

View or Edit VEA Preferences
Connect to VEA enabled hosts or domains to manage heterogeneous View or edit VEA Preferences such as appearance, language, favorites,
devices. and identities,

:_ Manage User Profiles ® View Online Help
(M2 pdd, edit or delete user profiles that allow you to save preferences per Obtain informatian on VEA and features installed on hosts that you
user of this application.

have cannected to,




dVE1-9-% (ZZTlE. veswin01) %38 L. "Connect’&7Uy I LTLIEEW,

Connect b4

Host Name: vc5w|n01| ~ Browse...

(®) Connect Using: Logged On User on this computer
(O Connect using a different user account
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TEO&IE GUIAIE EAYET, [Disks | #7UvIT 3L, 2 DOTAAINERRSNET,
[Harddisk0](& OS FATAATGDT, AELEVNTLIZEW, [Harddisk1 (No Signature) A% 7
—9EEH EBS TY, TARIICIIN-7 IMFWTW2BD(E. Offline THBIEZRLTVWEI DT, Z
DT4AT%EHIUYI LTI Online Disk |8 E L. T1AY% Online (CLETY,

() Veritas Enterprise Administrator

4

- o X
File Tools Actions View Window Help
Br % Jac ] 8 B
Connect  Disconnect | NewWindow | NewVolume New Group  Search
Select Host: | & vea://EC2ZAMAZ-HISTS3C:System/Disks/Harddlisk1 (No Signature)/ ~
f fia System @ Volumes &5 Disk View 4B Alerts
= [ ECZAMAZ-HISTS3C Disk: Harddisk1 (No Signature) Group name: BasicGroup.
System (g Cache Type: Basic Status: Offline
= g CD-ROMs Capacity:  8.00GB Unallocated space: 8000 GB
[ == gl Disk Groups Internal name:
o = gl Disks )
- & Harddiskl
({8 DMP D) New Dynamic Disk Group...
i & Enclos Add Disk to Dynamic Disk Group..
(& Sched
(3l Volum Online Disk
Change Disk Intemal Name...
Ping disk...
S.M.ART. menitoring...
Disk View...
New Partition..
Ul ST age [DHighusage [l Critical usage
G5 Properties | ..
Messages are not being filtered. Currently showing 2 messages.  Cenfigure this view...
! [Source Classification Message Rece
© [ ECAMAZ-HISTSIC  disk class Failed to write disk signature on Harddiskl (No Signature) Men
© [ ECAMAZ-HISTSIC  disk class Failed to write disk signature on Harddiskl (No Signature). Men

3 Console 5 Tasks

|3 EC2AMAZ HISTE3C




Online {LIC&>TININ=T I HER ELT. RIS, TARTIC

w01, [Write Signature |#38E L TS,
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Signature ZE2ZAHET, TIRTEHY

@) Veritas Enterprise Administrator

a X
File Tools Actions View Window Help
=Y G i i £ Y
Connect  Disconnect | NewWindow | NewVolume NewGroup  Search
Select Host: | &5 vea://EC2AMAZ-HISTS3C:Syster/ Disks/Harddiskl (No Signature)/ v
[ Tt System & Volumes | & Disk View [ Alerts
& [ EC2AMAZ-HISTS3C Disk: Harddisk1 (No Signature) Group name: BasicGroup
System i@ Cache = == Stotus: Online
=1 +~f CD-ROMs Grrr 20068 Unallocated space: 8.000 GB.
= %~ 531 Disk Groups Internal name:
L = gl Disks
ogs
{8 Harddiskd
uﬁ [ ] Ha iz
: g DMP DSM: New Dynamic Disk Group...
Control Panel Enclosures| .
788 schoued Add Disk to Dynamic Disk Group...
{53l Volumes. Offline Disk.
Change Disk Intermal Name.
Ping disk.
5MART. monitoring..
Disk View.
New Partition...
Write Signature... O High usage W Ciitival usage
@ Propetties —
% Messages are not being filtered. Currently showing 3 messages.  Configure this view.
1 [ Source . Message Rec:
© (] ECAMAZ HISTSIC  vdsprov class Successfully onfined disk. Mon
@ [ ECOAMAZ HISTS3C  disk class Failed to write disk signature on Harddisk1 (No Signature), Mon
© [ ECAMAZ-HISTSIC  disk class Failed to wite disk signature on Harddisk1 (No Signature). Mon
4 | »
[3 console 5 Tasks
&5 EC2AmAZ-HISTE3C LI

WRTAATEHETR L. Type ELTIMBRIZIEE LS, "OK &Iy LTLIZEW,

ECZAMAZ-HIST33C - Write Disk Signature

If you choose not to write a signature, your disk will remain as a disk without a signature,
and you will not be able to create partitions or volumes on this disk,

X

Writing a signature is a safe operation if you intend to use this as a Microsoft Windows disk.

Select the style of signature on disks:
(@) Master Boot Record (MBR)

() GUID Partition Table (GPT)

Available disks:

Selected disks:

= Harddisk1 (Mo Signature)

Select All>>

<Unselect

<< Unselect All

oK Cancel Help

"Yes" #7UvJ LT, Signature ZEZAA TS,

Confirm >
Q

INT, TART DI -TZER S BHERIZTE T TY,
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TAATTI=T1E. Linux ® LVM TE SFrD Volume Group [CAHH L.

VXVM CiUa1-L (RAETINM1R) 2R LTUERT 25 A RUI-ARSTVITNAOT1 AT T I -TIC

ELTWARENBYET,

TARTIN-T DR

T-5FT12A7 : Harddisk1 ZH27YUv%7 LTI New Dynamic Disk Group JZ#1EELET,

@) Veritas Enterprise Administrator
File Tools Actions View Window Help

ui ]

Mew Window

@ L] &

New Volume New Group  Search

Connect  Disconnes ot

- o X

Select Host: | &5 vea://EC2AMAZ- HISTS3C:SystemDisks/Harddisk1/

fis System @3 Volumes & Disk View B Alerts

Disk:
Type:
Capacity:
Int

Group name:

= [ ECZAMAZ-HIST33C
Cach Status

Harddisk1
: ache Basic

-l CD-ROMs 20068
51 Disk Groups

Unallocated spa

BasicGroup
Online

ce: 8,000 GB

New Dynamic Disk Group..
Add Disk to D; sk Group..

B Messages are G Properties Ssages.

1 [Source

© [ EC2AMAZ-HISTS3C
© [ EC2AMAZ-HISTS3C
© [ EC2AMAZ-HISTS3C
© [ EC2AMAZ-HISTS3C

|

gnature on

Harddisk1 (No Signature).
Harddisk1 (No Signature).

FEFER

[3 Console &5 Tasks

{3 ECoAMAZ-HISTS3C

TAAT T I —TF1ERK Wizard D325 EARUET DT, “Next>" 27U9I LT, FlTEA TS,

ECZAMAZ-HISTS3C - Mew Dynamic Disk Group Wizard

¥ Welcome to New Dynamic Disk Group Wizard

in which volumes can be created.

VERITAS

el

The Mew Dynamic Disk Group Wizard will help you to create a logical storage pool

< Back Cancel

X

Help
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TAARIIN-T2EAAL (ZITIE "awsdg” Z387E) . [Create dynamic secondary disk
group DI IARTVEFIYI L, [Harddisk11ZIEE L. “Next>" 27UvILT, FKITHEA TS

LYo

ECZAMAZ-HISTS3C - New Dynamic Disk Group Wizard X
New Dynamic Disk Group Wizard *
Enter a unique name for this dynamic disk group, and then select the disks to include. EE

Group name: awsdg
(®) Create dynamic secondary disk group
() Create cluster group
() Add private group protection
() Create Microsoft disk management disk group
() Create cluster shared disk group

Available disks: Selected disks:
'= Harddisk0 = Harddiskl
Select>
Select All=>
<Unselect
<<Unselect All

[~ Disk name(s)prefix:

< Back Cancel Help

[Harddisk1]A8 ESN TWBIEZHERRL. “Next>" 27U T LT, FKlCHEATRE,

New Dynamic Disk Group Wizard *
Here is the full set of disks that will be upgraded. If you selected disks to upgrade that contain EE

volumes which span onto other disks, you will see more disks than you had selected to upgrade.

S Disk Disk contains Will update I
Harddisk1 No volumes Yes

< Back T Help

c Disk Group Wizard X|
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WNAZREZL. "Finish” 2779 3&. TAAT I -TOERMITONET,

EC2AMAZ-HIST33C - New Dynamic Disk Group Wizard

Click Finish to create new dynamic disk group.

*

Create a disk group with the following specifications:

Group name: awsdg

Disks: Harddisk1

Microsoft disk management disk group: Mo
Private group protection: No

Cluster group: Mo

Cluster shared group: Mo

VERITAS

|

< Back LCancel

X

Help

BER/ -FTO VXVM ORY1-LETFIIV I AT LDOIERK

RICNYI-LEERELET, RUI-A, Linux D LVM TE
SBEREFCITNIIVY AT LOBEETNET,

SFr® Volume Y LES, MUI-LEER

TARI I =TDYERLICERENT D&, [Disk Groups]&7YvI93E . EREHDTARITIN-T
(C03HBA. awsdg) PRRENKT, ZOT1RTIIN-TEHTYYILINew Volume ] & ELF

ER

e — - o x
.... Tock e
G - (] =
Conn New indow | NewVolume NewGrovp  Sewch
P T e ——
" B 0ok @ volumes @ Disk View 48 Aets
- Ty Oy Fecondany)
e ype: Dynaic [Secenciny
2] 3 Ses 5 Tpe %o [Reemed [Wotlse |5
= yica_importes £000G3  Dynamic o onday M1
Contr el
Desoy Dynaic ik roup. ul
e e
Smoee U gure this view
APt Dy Dk G Probcien o —
S e D1k G Petecton e oo 1o dynane ik grous ameds EF 083 15 5T
ik Vi e on Hardeis (N Sgnature) HFIORIE 1SS0 5T
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veswinQ1 - New Volume Wizard

VERITAS

MU 1-LERK Wizard D325 EAVEST DT, "Next>" #7V9 LT, FKITEA TS,

file system options, and then creates the volume.

VERITAS

el

<Back Cancel

* Welcome to New Volume Wizard
@ The New Volume Wizard will help you create 3 volume on Storage Foundation

disks. Ftwill ask you for information on the desired layout, size, mirrors, logging,

x

Help

[Site Preference] 3 “Siteless"Z 5 E L TKIZEL, 2RIZ. [Manually select disks |[Z3§ET B¢,
RUI-LPERRICERINETAATIENET, "Harddisk1” 18 E L5, "Next>" 27Uy ILT,

FITEATLEEL,

veswinT - New Volume Wizard

Assign Disks for Volume

Storage Foundation will automatically select the disks used to create the volume unless you choose

to manually specify any of the disks to be used.

Group name: | awsdg

Site Preference

(®) Siteless
O Site Confined

() Site Separated

Select site from:

X

L

() Auto select disks
Available disks:

Name PCTL Size Site

& Harddi P2COTILO 8.000GB

[ Disable Track Alignment

[~ Disable Caching

Select All>>

<Unselect

<<Unselect All

@ Manually select disks

Selected disks:

[l = Harddisk1

Next >

Cancel

Help
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YERKT 2NV 1-LOFEHABEZRELE T, AWS D EBS (§. BETHABITRMEEZELEID
T, VXYM DLAYTI5-UVTEDTRALDHEEHYEE Ao TEETIL 5Gbyte DY A AZEFFD
"vol01"E WY 1-L%, TRALBL (26526, RUI-LERRICIEE TERT1ATA 1 RO
T, TRIELEINBYEZEA) EHRELTVNET HEFEEIRELLS, "Next>" 27UvILT,
FICEATIZEN, RYI-MNEHRLELIHE R, ICETOFEEERYIRL TN, H. & Tl
TUT-23VvAOOTIRY1-LEERRLET DT, ZERFEEZLTEVNIZERLEVTIZEW, OF
WNUI-LICHERRER, LTVT-YaydRRU1-LAOKED 1 EIRETT,

veswinO1 - New Volume Wizard

New Volume Wizard

Select the attributes for this volume.

Wolume name: vol01

Size: 5

x

L7

v Concatenated: A simple velume with a single copy of data on one or more disks.
i

< Back Next > Cancel

Help

RUI-LDIERRERBFCIFIIVI AT LEERR S 2D EINEIRTELE T, fEXT DT, [Assign a
drive letter|J#F Iy LI=5. “Next>" #7Uy I LT, FLITEATLEEL,

veswinG1 - New Volume Wizard

*

L]

Add Drive Letter and Path

You can assign a drive letter to this volume,
An NTFS mount peint can not be assigned if the host is remote.

(®) Assign a drive letter: |D: v

() Do net assign a drive letter

() Mount as an empty NTFS folder: Browse

< Back e




71V ATLELTINTFSJEIEE L5, “Next>" &7UvI LT, FLlTEATZEL,

veswinOl - New Volume Wizard

Create File System

allocation unit size.

[¥ Format this volume

Select a file system:
FAT
FAT32

ReFS

File system cptions:

Allocation size: Default v
File system label: volo
[V Perform a guick format

[" Enable file and folder compression

v NTFS: minimum volume size is 3.000 MB

You can format this volume with a specific file system, label, compression methed and allecation
size, Choosing the option *Default" will allow the program to provide optimal values for the

X

i

Cancel

Help

VERITAS

WAZHFEL. "Finish” 27Uv795& RUI-LRVTFNIIVIAT LOERATTHON YOV RETITD

ngxy,

weswinQ1 - New Volume Wizard

Y

Click Finish to create a new volume.

Create a volume with the following specifications:

Type: Concatenated volume
Disks: Harddisk

Group name: awsdg

Size: 5 GB

Volume name: vol01

Drive letter: D:

File system: NTFS
Allocation unit size: Default
File system labek vol01
Quick format: Yes

Enable compression: Ne
Volume Type: Siteless
Caching Enabled: Yes

VERITAS

el

Help




VERITAS

ERRICR IS B, GUI DEEFI D[ System |57 Uy I LR, [Volumes 27Uy 9 5L, fEREHDIN
J1-L (COFE. volo1) PRRSNIBELEFSIILY- (C0iHE. D) HEIYHTENTWEIE
NHERTEET,

) Veritas Enterprise Administrator - o x
Fle Tools Actions Wiew Window Help
G = -} = 8 i}
Connect  Disconnect | NewWindow | New Volume NewGroup  Sesrch
Select Host: 3 veax//veswinDT:System/Volumes/ =
it o System | & Dicks [J irors Bl Logs & Subdisks @@ Snapshot Volumes @ DCO (3 Shadow Storage ) Disk View 8 Alerts
= - & veswin0l Name: woll1 (D) Group name:  awsdg
System 3 Cache Type: Concatensted Status: Healthy
= & CD-ROMs Sze: 50068 File system type: NTFS
= g Disk Groups Velume name: velll
awsdg
= o
?_] =i- @il Disks.
S Harddisk
Control Panel & Harsdisk
5 Fetching ot
(5 oMP DsMs
& @ Enclosures
() Scheduled Tasks
T Messages are not bring filtered, s
| ! Received
Y n Added drive letter D: to volume ¥DevicedHarddiskDmiolumes¥awsdgWvol0l.  2019F10F 35 1653064228 JST ]
el . 9 0AIE 168508218 5T
el gt WIS 0FIE 168062208 5T
el ¥DevicedHarddiskDmVolumes bswsdgh... 20195 105 35 1633084198 /5T _
el sdgivel0] has smived, WIS 0FIE 1683065138 5T
el ISEWAIT 158168508 5T -
| (|
[ Console & Tasks
2 weswina1

INT, BERO VXVM DERTE [F5E T T,

R/ - FTO VxVM BIEDIESE
HR/-RTE TIAVORBHOMY 1-LOERETETVNET , BEB ML TAAIDIA-VYbERFA

AN

TVI-OT7HAVETHEN 2 ROA T, ZNUNDES (T1RITN-TEZ2PRI1-LOYAX%E) 32T
ELCICLTLIZEL,

BEREELRZANL-VIY
FIATLI-DT YAV IFATHENTIEN,

veswin02 - New Volume Wizard X

Add Drive Letter and Path

*
An NTFS meunt paint can nat be assigned if the host is remote.

® Do not assign a drive Ieiter

ITFS folder: Browse

< Back Cancel Help




[Format this volume ]| #FIv7 LEWN TS,

veswin02 - New Volume Wizard

X
Create File System
You can format this velume with a specific file system, label, compression method and allocation *
size, Choosing the option *Default” will allow the program to provide optimal values for the
allocation unit size.

I Format

Select a file system:
FAT

FAT32

File system opticns:

Allocation size: Default
File system label: vol01
¥ Perform a quick format

[~ Enable file and folder compressicn

v NTFS: minimum velume size is 3.000 MB

Cancel Help

VERITAS

R OTERE T GUI OZFI D[ System 27Uy UIRE. [Volumes 27Uy 95 fERE
HORYI-L (CDHE. vol01) HFRRSN, FIATLI- BN HTOENTWVERNENHEFR TEXT,

@ Vertas Enterprise Administrator

- o x
File Tooks Actions View Window Help
& LY o = 2 B
Connect  Disconnect | New Window | New Volume New Group Search
Select Host: | il vea//veswin02System/Volumesvol01/ -
k T System S Disks [ Mimors B Logs & Subdisks & Snapshot Volumes &2 DCO ([ Shadow Storage @ Disk View @ Alerts
=[50 veawint2 Name: il e
&l Cache Trpe Concatenated Status: Heslthy
= ‘@ CD-ROMs Size: S00GB File system type: RAW
E- gl Disk Groups Volume name: voi0!
Logs BasicBroup | Device <4 | Internal na._. | Dynamic 4. | VDID Status Size | Type |%Used  [Reserved  |HotUse
'f] & g Dsks © Haddisk!  Disk! awsdg WsPhysica. lmported 800068 Dynamic (SN No Secondary
& Harddizkd
Control Panel & Harscisk !
% DMP DMz .
@l Enclosures
Scheduled Tasks B
E @l Volumes
)
=
4 | ’
W Homai usage [ High wsage [ Crtical usage
B being filtered. y
[- Source Classification Meszage Received
© 13 veswint2 i Crested A19E 105 3T 1657214358 ST =]
© [ veswing2 dynamic disk i 2019105 35 165214348 15T
© 13 veswin(2 pnp class Device ¥Device¥HarddiskDmvolumes¥awsdgirolD] has anived. 21910535 165215348 5T
© (0 veswind2 dynamic disk and volume class  Added Harddisk1 o dynamic disk group awsdg, 21910735 1633195 208 ST
© () voswingz ik class Wrate disk signature on Hardisk | (No Signature). 2019%F 10533 162198 108 5T —
© 8 veswintz wdsarow class Suceesshully onlined disk. 201910538 168195008 JST B
i [
[ Console 5 Tasks

[ veswanoz I




5. VVR [C&BL TV =23y E{T51-0 D% E

ZZTIE LTV =2ay[CihE R VR EF1UTA Y —EADEREITVET,

VVR Security Service DR
CDIEEIL. BREIRTOHTH> TS,

AF—-MXZ1-

- g Enclosures
(& Scheduled Tasks

ale

. ia File Share Configuration Wizard  Windows Server
=

1IS Configuration Wizard

MSDTC Configuration Wizard % 2
A Windows Windows

MSMQ Configuration Wizard PowerShell PowerShell ISE

Oracle Configuration Wizard

Print Share Configuration Wizard #-
# Windows B JVRO-JL (%
SFW Support Tools. U=l 1%

SharePoint Search Configuration...
S

SharePoint Server 2013 Configur... af
E YE=h7ATby
TgE AR E2-7-

SharePoint Server Configuration...

Solutions Configuration Center
SQL Server Configuration Wizard
Veritas Enterprise Administrator

Volume Replicator Agent Config.

VVR Security Service Configurati...

“Next” #7Uy LT, LISEATLESL,

h'5. [VVR Security Service Configuration |#34TL L&,

Veritas Volume Replicator Security Service Configuration Wizard

This wizard helps you in configuring the Veritas Volume Replicator for Windows Security Service(VxSAS).

When configuring a Replicated Data Set (RDS), WR performs operations on multiple hosts, using the account
information of the local VxSAS service for authentication on the remote hosts. You must therefore configure the
V4SAS service with the same account name and password on all the hosts, that are intended to be a part of the
same RDS,

To canfigure VxSAS service on multiple hosts, this wizard prompts you for:
1. An account name and password.
2. Names of the hosts where you intend to configure the VR Security Service.

Prerequisites:

1. The account should have logon as service privil all the specified hosts.
2 The selected hosts should be reachable from the local host.

Next Cancel Help

VERITAS
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BER/-FOEEE ID L/AAT-FE2AAL. "Next” Z7UvILT, KILEATIZEN,

zard x

ount Information VERITAS

b Enter the account information

FEBRNTTS IWORKﬁmummmmmtm
(domain¥account)

Password: [~

Make sure that the account name you specify has *administrative® and “log on as service” privileges on
the required hosts.

Back Next Cancel Help

"Next” #7Uy 7 LT, FTITEATES,

Veritas Vblume Replicator Security Senvice Configuration Wizard x

Domain VERITAS

Select the domain to which the required hosts belong.
Click Add domain to add a new domain to the Available domains list if itis not already present.

Available domains Selected domains

'WORKGROUP

|
=

Add domain

Hosts in a selected domain can be configured only if the user name and password of the local host are
valid and have administrative rights in that domain.

Back Next Cancel Help

A T0Oladd host]&7UwI L. BERKAME%Eadd LTS,

Wizard X

VERITAS

¢ Select hosts from the discovered hosts list. If the desired hosts are not yet discovered, you may add them manually:

Discovering hosts for domain WORKGROUE..

Available hosts
Add Host X

Host
Host name: | veswinl 1]

Add Cancel | Help |

Make sure you select all the hosts for which you have not yet configured the VxSAS account with the
specified username and password, but are intended to be a part of the same Replicated Data Set (RDS).

Back Configure Cancel Help
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& TOladd host |7, i RINAM &% [add|LTz5. "Configure"&7 Uy I LTLIZEW,

Veritas Volume Replicator Security Service Configuration Wizard

VERITAS

Select hosts from the discovered hosts list. If the desired hosts are not yet discovered, you may add them manually

Discovering hosts for domain WORKGROUR..

Available hosts Selected hosts

Host Cluster Host Cluster

veswinl

N veswin02
<

Make sure you select all the hosts for which you have not yet configured the VSAS account with the
specified usemame and password, but are intended to be a part of the same Replicated Data Set (RDS).

Back Cenfigure Cancel Help

TEROLSIC. mAD/-FTlAccount update succeeded IBMFRREINNIETE T T,

| e v ey wivup

e awsuy

Veritas Volume Replicator Security Service Configuration Wizard

Configuration R

VERITAS

Configuration status details on selected hosts

Host Status System returned error messagy
veswin02 Account update succeeded
<

Cenfiguration status details for the selected row

|Account update succeeded on host veswinO1.

Back Einish | Cancel I Help




VERITAS

6. AWSCLI D&5E

AT AWSCL ORERKY IAM O-JVREOHAERELET, INEOFLVFIRICONTHE, B
NFIFED[ Veritas InfoScale Enterprise 7.4.1 for Windows on AWS #EFEE EBS ZHVN\HEB T
7 + Private IP Y)E#R] D 30~38 R-JEIZ RS, 2L, L ER IAM O-)VOAREERZYETO
T, ZOBMHOHEERLET, FFIAV D URL LT TY,

FEOBR/NY-Y THER IAM O-)L O

KEOERTIE. TIAR-FIP OILE L FEIN-FT-TIVDEH % InfoScale h'HHIEITEZHENHYET,
R T U FORABTRYY-21ER L. ZNICEIER (F0-)V%. InfoScale B’ YAR=)VENTAY AT YA
FICEIY ZTTEE,

aws H—ER v UY-RTL—TF ~ %
Identity and Access AUz — > ves-policy
Management (IAM) ‘. *EEE
+ AWS Account (270797224473)
Hyzai— MUS—ARN  am:awsiam::270797224473:policyives-policy ()
G- B vcs-policy
LT FOURER  ARUS—OERRE | RUS—0)N—Ya>  FIERFPRIAYF—
o—JL
AUz — RUS—HE MU —DEE
ID 705 — {
. "Version":
5 o =
FhozbaEE Statement™: [
SEHERLT— {
'sid":
Q "Effect™:
Action": [
~ AWS Organizations
Organization activity
Service control policies (SCPs)
1,
"Resource":
}
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VERITAS

1. WR[Z&BLTVT =23V T5EHD IS5 A9 -BIDRTE

VR IZEBLTUT=23v & IP BETITVWESH, ZEOEBRTE. LTUT-YavIcERT3 IP PLTUT-
VIV ROM1I-LZFFELETIIATI-OEE - B/ TICBMENHYET, ZZTlE. ZNODREEITTVE
ER

JIIR5-EE GUI DTYAR=Ib

COYEER. MAD/-FTIT>TLEEW, UE-FD Windows YV YDBI5A5F -0/ - RICUE-MERLTY
FAI-ERELIEWNGE . ZONYY LICEAV AR ILLTHLEEFTT,

NYZZDOBAH ( ) TEFEEEZAALE
. TVCS Cluster Manager Java Console 7.4.1 (Windows) |25V 0-FL TSN, Fv0-
RLET7AIVE, GUI &ty 7y TUTW Windows VI VIIRTEL, I TV ILTLESL,

7]
3

VCS_Cluster_Mana
ger_Java_Console_
7.4.1_for_Window

“Next” #7UyIL T, LIEATLESL,

‘I%] VERITAS Cluster Manager - Java Console - InstallShield Wizard *

Welcome to the InstallShield Wizard for
VERITAS Cluster Manager - Java Console

The InstallShield(R) Wizard will install VERITAS Cluster Manager
- Java Coneole on your computer, To continue, dick Mext,

VERITNAS

il



https://www.veritas.com/trial/en/us/vcs-utilities

"Next” Z7UvILT, FILEATIZEN,

ﬁ WERITAS Cluster Manager - Java Console - Setup x

Install VERITAS Cluster Manager - Java Console to:
C:¥Program Files (x86)¥VERITASY Change...

Installshield

“Install” #27Uy I LT, FLIEATESL,

ﬁ VERITAS Cluster Manager - Java Conscle - Setup X

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard,

Installshield

< Back Install Cancel

[Finish]1Z27Uv L. 1Y AR=IVESE T LTLIZEW,

‘ﬁ WERITAS Cluster Manager - Java Console - Setup X

VERITAS Cluster Manager - Java Console
Install Wizard Completed

The Install Wizard has successfully installed VERITAS Cluster
Manager - Java Console. Click Finish to exit the wizard,

VERITAS

el

VERITAS
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JS525-EE GUI DEEENE, V5AFT-DE-FEE
TV, IIAT—EER GUI ZA VAR UE/—RASES, EIHBIT>THIEE T,

Windows DAY —kXZ1-h'5 “Veritas Cluster Manager” Z27Uv7 LT, GUI 281 TSN

Veritas Cluster Manager - Java Console
*f= Veritas Cluster Manager - Java Co...

@ Solutions Configuration Center B
v <3

Windows
KETT PowerShell ISE

== avyK Jov ik

Sniping Too G L]

e
-
Windows B Y-l G
& KAh J-W 529 W3- I

XER

Al L] 5]

YE-h FATby
T®E ANVt Ea1-7- I7270-5-

£ Cluster Monitor - X
File View Help

Mew Cluster

& Veritas™ Cluster Server

e

Cluster Manager

JIAT-MYAR=EnTz)-F2ELLE IP PELAZA AL, "OK" 27Uy ILET,

@ Mew Cluster - Connectivity Configuration *

Host name vcswinﬂﬂ
Port 14141

Failover retries |12

Ok Cancel




VERITAS

IR LRI ELEI-Y -2 NAT-F (FIAINTHRELTLWNIEL, 1-T-%
(& "admin”, ){XAT—-F[& “password"TY) ZENMNEIDT. AHEK"OK" £7UvILET,

@ veswin01:14141 - Login X

sername |admin

Password 09998

OK Cancel

TROLE GUINLE ENVET, F5RAT-DEREEE CERE-NIT N EINBENMNETD
T "yes" &7y I LTS, INT, #EfBEE T T,
€9 aws - Cluster Explorer: 2 Cluster A _ o

ghibhda BB & DA EOOFERWEE S @

& a9 @ Status Remote Cluster Status Senvice Groups [ System Connedtivity [£] Properties

= & Status View: aws
+ Global cluster option is enabled for this cluster aws.
* No Remote clusters configured.

(-?,' Status (All Groups status on systems) : aws
No group is configured on this cluster!

Systems » Rermote status

L]
WCSWWINGT WCEWINDZ

Cluster Configuration x
o Cluster aws has no service groups !
Do you want to use a wizard to add service groups ?
Note that this will change the configuration to read/write mode.

No

aws
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LIVT-93001EERZY-ERITIN-TOERK

T LTVT=2ay 0B EBRY-ERIN-TEERLES, COY-ELATI-TE. LTVT-23vIiiin
TR IP TRVAE VWM OIVR-RY MEEELES, IholE LU -vayse (F3147)) eLTur-v
vk (ThyFY) OmATEMELES DT, COY-ELAIIN-TIEmAD./-FTEREFC Online (LHRYET,

HLEOY-ERIN-TOFREMEITINIVET UV ILETS,

€3 aws - Cluster Explorer : admin ( Cluster Administrator ) - O x

File Edit View Tools Help
Aha(ERd @ WO FO0 s/ BABAEE B O
& Gl @ [add Service @mupﬂ Stalus [A] Remote Cluster Status [ Senice Groups [ System Connectivity [E] Properties

£ aws

& Status View: aws

+ Global cluster option is enabled for this cluster aws.
* No Remote clusters configured.

(%) Status (All Groups status on systems) : aws

No group is on this cluster!
o <
Systems » VCEWIND1 VCBWINDZ Remote stalus

aws

Y- -T2 &L Treplication |38 E L. COY-EATN-TaH@IEZ/-FELT I5R%
-DEAFD/~F (veswin01 & veswin02) ZI8EL. 75AY-RERFCBEICT-LATI-TF
B Online (L35I Startup IOF TV IRV I RICFIVIEWNET, £, BHRLELIICCOY-E
AIW-FFEA D) - FTREFIC Online (LY ET DT, Type ([ Parallel [ZIEELET, B ESR
B ANDLES, "OK"&I)y I LTI,

€@ Add Service Group X

[ﬁ Add Service Group

Senvice Group narn

Ayailable Systems Systems for Senice Group

SysterTTAmE Starwe Priority
.

Senvice Group Type: () Failove

Selected Template: None Templates ...

Fl, show Command OK Cancel
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TED&IIC, Treplication ] EWSY=EATIN-THMERSNELEAFEETIDT, IP TRLAP
VXVM QOIYR-RY b EERY 31DV -AE/ER Y DR ENHYET, UY-AE/ERT BRI,
9. EDFIDOVY-AZERLEWT-EATIN-T (C0FmEEreplication]) &7UvIL. LN T

FRERD[Resources |7 T &IV LET,

€8 aws - Cluster Explorer : admin { Cluster Administrator )

File Edit View Tools Help

T T LI XY P T RY I X

& Gl & nerues
s
replication

& View: fion on all

¥ uink] ¥ Ao renae] (2]

& b

replicati WOSWINDZ VCSWINDY

replication

BREDEDCRIVIEEDEEIYYITEEAZ1-IMHET DT "Add Resource” 7y T

&V,

@ aws - Cluster Explorer: admin ( Cluster Administrator )

File Edit View Tools Help

gl BB & BB EFOO s B2 adE W@

T ] [ status [ Resources ] Properties

& Resource View: replication on all systems

replication

Add Remote Group Resource...

Paste

o a a

replicati... YCSWIND2 YCSWINDT

replication

29
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£\ NIC 2ERIBYY-R&/ERLET, YY-R&[ETwinic]ELTWETS  UY-RF1T1E TILY
TIDBG “NIC" ZIRATLEN, HZBNTA-T =& "MACAddress” TI DT, BRI Edit V-7%<

YTy ILTLIEEL,

L
@ Add Resource
EB,, Add Resource
Group name: replication

Resource name: | ywric

Resource Type Hie T ﬂ
Attribute name  Type Dimension Value Edit
MaxTxErrorPerc...Integer Scalar 50 4 ”
MaxTxErrinterval Integer Scalar 10 [
UseConnectio... Boolean Scalar rue [
MACAddress String Scalar
PingHostList  String actor 4 v

Critical [] Enabled
1, Show Command OK Cancel

Windows @ ipconfig ENIVY FTHll/—FD MAC PRELAZRARNA D LET . MAC 7RLARIZY
ATLECEBYETOT, L£BID "Per System” ZF1v7L. TINAFVIT/-ERUBAS, @EYIR

MAC 7RLAZ AN LTLEEL,

@ Edit Attribute

@ wrnic

MACAddress

physical address of a NIC.

The physical address or the name of the network interface to be
monitored. Note that this attribute is always local, thatis, itis different
for each system. You can use the ipconfig -all command to retrieve the

() Global Scalar Value
(@) Per System 06-FA-EF-55-80-48]
VCSWINDA ~

OK

Cancel

LTORERNIA-F-DANIET LIz6, TERD “Enabled” [CFIYI%EAN, "OK" 27UvIL

TYY-2EREEITLTKIAL,

48 Add Resource

(E,, Add Resource

Group name: replication

Resource name: WIniC

Resource Type MIC

Aftribute name  Type Dimension Value Edit
MaxTxErrorPerc.. Integer Scalar 50 i ~
MaxTxErrinterval [nteger Scalar 10 [
UseConnectio . |Boolean Scalar Tue (2
MACAddress  String VCSWINO2={0... &
PingHostList String ‘ector =4 W
Critical Enabled
1, Show Command oK Cancel
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LUFO&S(Z, "vwrnic” EWSUY-ADER SN E LT, NIC (3. OS EEIRASIRENRRETT DT,
DY -ZERREE NS, Online #RI KB TRTINET,

File Edit View Tools Help

ddid e & HB EOO0Fr B wEE B @

) [E status Bl Resources [£] Praperties

& aws i
Resource View: replication on all systems
N replication % P

o Link| B Auto Arrange | |2

& 3l a

replicati WCEWINDZ WG EWIN T

RIS LTVT—3ayTERTS IP2EBIBUY-AZERLET . NICDBRERLKIIC, HITUY
Jh5IAdd Resource |[F3EELE S, UY-AZ& [ [wrip ] ELTWET, UY-ZF1T (L. FILFTIUH
5 "IP" Z3RA TSN, thZB/VIX=45—(F "Address”. "SubNetMask”, “"MACAddress” T D
T, ZNZENAE/IO Edit Y-7%<YTYy I LTS,

€8 Add Resource ®
[ﬁj Add Resource

Group name: replication

Resource name: wrip

Resource Type: i - B
Aftribute name  Type Dimension Value Edit
IAddress String Scalar
SubNetMask \String Scalar
MACAddress String Scalar

Critical [] Enabled

El. Show Command OK Cancel

LFIUT—2ayTERTS IP PRLVAGY AT AEBCEBYETOT, LRI "Per System” ZF1v7
U T IVT)-ED RIS, B IP 7 ELAZ AN LTIZEW, ZOBITIE, BREIR (G

10.193.44.11, F#£3%(3 10.193.54.12 %

€ Edit Attribute X

@ wrip

Address
Aunique virtual IP address to be assigned to the NIC.

O Gloval Scalar Value E
@ Per System 10.193.44.11 ]
VCSWINO1 v

oK Cancel

RELTWET,
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FYMNATEANLET , RV YATLTHELED T, Z£8I0D "Global” #FIv/JL. %
1 2FRFAALET, ZOFITIE, 255.255.255.0 #%ELTVET,

@ Edit Attribute
@ wrip

SubNetMask

The subnet mask associated with the IP address

X

® Global
(O Per System
VCSWINDT

ScalarValue
1255.265.255.0

oK Cancel

RIZCMAC TRLAZAALET, FiEE. 5IRO NIC VY-ZADHEELRUTT,

LTOBERNIA-F-DANNET LIz6, TERD “Enabled” [CFIYJ%EAN, "OK" 27UvIL
TYY-RERREEITLTIEEN,

@ Add Resource

X
Eﬁ; Add Resource
Group name: replication
Resource name: wrip
Resource Type: P - ﬂ
Affrioute name  Type Dimension Value Edit
Address String Scalar MCSWINO2={10... ¥
SubNetMask String Scalar 255.255.255.0 %
MACAddress String Scalar VCSWINO2={0E... [
Critical Enabied
1, Show Command oK Cancel
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LUFOEKSIC, "wrip” EWSUY-AMERRSNE LT, COBF R TERELE IP PRLAIKIIE EAST
WEBADT, VY-AERER (L. Offline # RIIKETERRINET, UY-AEHIUYITEHEX
Z1-HH230T. mAHD./-KT Online [CLET,

€8 aws - Cluster Explorer: admin ( Cluster Administrator )

File Edit View Tools Help

dfpra b W & DD FOO 7 BHE adE & O

W 9 @ [d status [ Resources ] Properties

& Resource View: replication on all systems

B Auto Arrange

Offline
Offline Prop
Clear Fault

Probe

& ] T | Enabled
replicati WCSWINDZ YCSWINDT Critical

replication Link_..

UY=21" Online [CB5E, TROLIIKELHEYET,

€8 aws - Cluster Explorer : admin ( Cluster Administrater)

File Edit View Tools Help
bl B d E S FOOELWEE S O

=1
& G & [F4 status [ Resources [E] Properties. L

5 aws
[E8% ] replication

& Resource View: replication on VCSWIND1

o Link| 55§ Auto Arrange

da

replicati..

El ]
WOEWINDZ WCSWINDT

replication

33
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IP 7RLAI #ELE NIC ETIZE EMYET DT, £E L% NIC O Online 7Y IP 7 RLA
Online [C3 2% M THINETY , CDKFEIRERETILENHYVET, UV-R&ETYYITS
EXZI-NHBDT, "Link' 27y ILET,

£ aws - Cluster Explorer : admin ( Cluster Administrator )

File Edit View Tools Help

dbd bW @ D FOOT L WBE S @

o G & [ status Resources  [£] Properties:
@ aws Y
= Resource View: replication on VCSWIND1
5N cpiication | 3 Auto Arrange
1P i
View >
Oniine >
Offine >
Offine Prop >
Clear Fault >
Probe >
] B |V Enabiea
replicati VCEWINDZ VCEWING v Critical
replication Link..

EDVY-RIKTFT BN EEIRY BEEICTIVEDYXI DT, "winic” ZEIRL, "OK" 27YvIL
URFREREEERLET,

@ Link Resources X

i@ Parent Resource: VTP

Group: replication
Child Resource:

ELIKRFRRNERINSL. TROLICHYET,

{8 aws - Cluster Explorer: admin ( Cluster Administrator )

[m} X

File Edit View Tools Help

bl B R & L EOO7BLWEE S @

&% 4 @ [ status 1 Resources 5] Properties
S aws o
Y picaiion | &% Resource View: replication on VCSWIND1

L3

replicati

7] [7]
VCSWINDZ MCSWIND

replication
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AWS ETE B ECQAVAIVALTIP PRLAZIE LTI TIE AV ATV ADNEDEZD
IP 7RLAICT VAT BEETEE A, INERBECT BICE. AWSCLI #HEARLTI VATV AAND
P 7RLADTHAIDBETT, INEITIEHDUY-REERLET . NIC DBRERILEKSIC. HIY
5 Add Resource |[#38ELE Y, UY-A4(Ewrawsipl ELTWET , UY-RF1T L TIVS
DB "AWSIP" EBA TS, ZBINTA—=F—[F “PrivatelP”, "Device” TSN T, ZNZNH
BID Edit V=7%LYIUYI LTSV,

{g Add Resource X
Eﬁ Add Resource

Group name: replication

Resource name: wrawsip

Resource Type: NWSIP e i
Attribute name  Type Dimension Value Edit
PrivatelP String Scalar (4 ~
OverlaylP String Scalar [
ElasticlP String Scalar [
Device String Scalar
RnuteTahlald: Strinn aulict 2 2

Critical [] Enabled

ow Comman ance
Show C d OK C: |

LFUT -3y ERTS IP PRLARYATLAECRBYETOT, Z£BI0D "Per System” FIv7
L. WAV T)-REVEAS, BEIE IP 7RLAE AL TLESW, COFITIR, BER(E
10.193.44.11, FFHR(L 10.193.54.12 2R ELTVET,

{3 Edit Attribute x

@ wrawsip

PrivatelP
Secondary private IP address of EC2 Instance

() Global Scalar Value
®) Per System 10.193.44.11
VCSWINDA -

OK Cancel

RIZ, "Device” # ANLET, F &L, 5ik® NICUY-AD MAC 7 RLALRILTY,




VERITAS

LTOBEBNSA-F-DANDET L5, TERD “Enabled” [LFIvI%Z AN, "OK" 27YvIL
TUY-2EREEITUTIAL,

‘ ¥@ Add Resource X |
% Add Resource |

Group name: replication

Resource name: |wrawsip |

Resource Type:

Aftribute name  Type Dimension Value Edit
PrivatelP String Scalar [ ~
DverlaylP 'String Scalar 4
ElasticlP String Scalar &
Device String Scalar %
RouteTahlald: Strinm K evlist % &7

Critical Enabled

E1, Show Command

BUFOESIZ. "wrawsip” EWIUY-ANMERRSNE LT, CORFRTERELE IP 7RLAIK AWS £
TIIT7HAVENTVERADT, VY-AERE# (T, Offline Z/RIIKEETRRINET, UY-R%
BIUYITBEAZ1-NHBDT, WAHD./—FT Online [CLET, Online [CA2E, 7AIV0EHR
KBIKDYET,

£ aws - Cluster Explorer : admin ( Cluster Administrater ) - m] *
File Edit View Tools Help
didhia B BA @& BB HFOOrEBEL wdE % O
W g @ [ status B Resources [£] Properties
& aws * o
— Resource View: replication on all systems .
= % [T o Link| 5 Auto Amange | |2
& AwsIP £ g
[T
@ nNic
Wrawsip g‘
o tip
View >
VCEWIND2
Offline
Offline Prop
Clear Fault
Probe >
~ Enabled
~  Crifical
Link
% Unlink
replicati.. VCEWINDZ WVCSWIN
Actions.
replication
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AWS [Z&B IP PRLADTHAVICIE BAVATIVALTIP PRLANIIE EHH>TVNBRHELAH DD
T. 5 ¢%52 IP @ Online Y AWSIP 7RLAD Online [C 354 THAINETT , ZDRIERIZ
ERETILENHYET, VY-AEHTUYITEEAZ1-DHEBD T, "Link"&27UvILET,

€8 aws - Cluster Explarer : admin (

Cluster Administrator )

- [m] X

File Edit View Tools Help

dih B ed & SBHOOy R aEH B @

EE K]

& aws

EE-J repiication]
o @ AWSIP
@ P
@ NIC

[ status Resources [£] Properties

&5 Resource View: replication on VCSWIND1

3 Auto Arrange

wra

3 1] ]
VCSWINDZ MTEWIN

replicati

Wrawsip

View

Online
Offline
Offline Prop

Clear Fault

Probe

Enabled
Critical

Link...
Unlink...

Actions

EDVY-RIKTFT 2N EEIRY BEEICTIVEDYXT DT, "wrip” 4R, "OK" 27YvIL
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@ Link Resources

@ Parent Reso

Group: replication
Child Resource:

Wrnic

Urce: vwrawsip
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COEEIL. EBE6N—HD/-FD VXVM O GUI MBiTWET,

"Select Host” O FIVF T XZ1-h'5 "vea//Replication Network/” Z3IRLET,

@ Veritas Enterprise Administrator - o X

Eile Tools Actions View Window Help

o o [

NewVolume NewGroup  Search

(&1 Cache
L % " oo
o9 - DMP DSM. &g Disk Group:
wﬁ & Enclosures % Disks
(@) scheduled Tasks DMP DSMs
Control Panel 31 Volumes @ Enclosures
(&) scheduled Task:
lumes

Messages are not being filtered. Currently showing O messages.  Configure this view..
t [Source Classification Message Received

[3 Console & Tasks

"Replication Network/” D71V &EHIUYITEEXZ1-NHBD T, "Setup Replicated Data
Set” Z2FEIRLET,

@) Veritas Enterprise Administrator - o X

File Tools Actions View Window Help

EY Juc

Connect Disc: New Window

Setup Replicated... Monitor View

Select Host: | 8} vea//Replication NetworkeSystemy/

W & | |2 Replcation Network B8 Monitor iew
3 il
stem Setup Replicated Data Set..

View Mermory Usage

Open Graph
G Properties

sssssss

W% Replicator Log Used  [l% DCM Log Used

Messages are not being filtered. Currently showing 0 messages.  Configure this view.
t [Source Classification Message Received

[B Console 55 Tasks.

[E Replication Network [
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Setup Replicated Data Set Wizard X

* Welcome to the Setup Replicated Data Set Wizard
~
% What is a Replicated Data Set?

Data is replicated from a Primary host where an application is running, to one or
more Secondary hosts.The volumes on a hest that participate in replication
includes; the volumes that contain the data and the volume that is used as the
replicator log. These volumes are grouped together o form a Replicated Volume
Group (RVG). An RVG on Primary host, and its counterparts on the Secondary
hosts, form a Replicated Data Set.

To create the Primary RVG, the wizard prompts you for information on:
1. Replicated Data Set name.

2. Replicated Volume Group name.

3. Primary host name or IP address.

4, Dynamic Disk Group.

5. Volumes to be replicated.

6. Volume that will be used as a Replicator Log.

To add the Secondary, the wizard prompts you for information on:
1. Secondary host name or IP address.
2. Replication Settings.
Before proceeding, make sure that Veritas Enterprise Administrator (VEA) is
connected to the intended Primary host and the volumes to be replicated are

‘ available on that host. b

< Back Cancel Help

VERITAS

Replication Data Set, Replicated Volume Group D% BIZ AN LET, ZOFITIE, ZhzEh
[rds01]&rvg01 %38 L TVET, Replicated Volume Group (3. SEZ(CERT 2O THMYY
FVRFRICLTLZEW, “Primary Host” [C[3. #RE1FR/—FTH B veswin01 ] EHEELET,

[ Setup Replicated Data Set Wizard x
Enter names for Replicated Data Set and Replicated Volume Group *,
Select the desired Primary host from the list of connected hosts. "Eﬁ,p
Replicated Data Set name : rds01

Replicated Volume Group name: | rvg01|

Primary Hest: wveswinD1 w

v Veritas Enterprise Administrator{VEA) should be connected to the desired Primary host.

< Back

Cancel Help

LIV =23y Rk 1-LILFIYI2WNET ZEOFI TR 1 DEBTIN BHIEETSFE

ATHETY, IETEH. "Next” &7VvILET,

Setup Replicated Data Set Wizard x
¥,
Select Dynamic Disk Group and volumes to be replicated. %
i

Dynamic Disk Group : |awsdg ~

Select Volumes :

¥ |Volumes s Layout Size

vol0 Concatenated

1 ' Windows Disk Management compatible Disk Group, Storage Foundation RAIDS volumes and volumes having
Dirty Region Log are not supported for replication.

<Back Cancel || Help
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RIZLVTVT-vayeEARTZ00RMN)1-L%BIRSZBEECEYETH, OJRY1-LRBERLT
WALDT, "Create Volume” #7UyILEY,

| Setup Replicated Data Set Wizard X
Select or create a volume for Replicator Log )K'#
i

Select a volume from existing ones or create a new volume for Replicator Log.

Select a volume: Create Volume

Wolumes | Layout |Size

v The Replicator Log is a volume which is used as a circular buffer to queue the writes on the Primary host before
they are sent to the Secondary. Each RVG must have a Replicator Log. VWR uses this log to keep track of the
order of writes.

In the asynchronous mode of replication, to prevent the Replicator Log from overflowing, this volume must be
large enough to hold all the writes until they can be sent to the secondary. Use the VRAdvisor tool to estimate

the optimal size of this volume.

Mext > Cancel Help

T 56T, "Harddisk1” _EIZ. 1Gbyte DAZET “srl” WS FIOOIRY 1~ LEERL TN E

I, OJNYI-LACHEBREE LTVT-Y3ay /KRNI 1-LOKED 1 EIFRETY,

Create Volume X
Name: |srl Size: |1 GB ~
et Mirror Information
(® Concatenated
Striped [~ Mirrored
Columns: |2 Stripe unit size{Sectors) : | 128 = Tmerse |2

Disk selection
I~ Thin Provisioned Disks Only

() Select disks automatically

(@ Select disks manually

Available disks Selected disks
Name Site S Harddiskl
B Harddiskl | _m

Add All
Remove
Remove All

OK Cancel Help
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07U a-LaEREN 5L, 0PN 1-LBIREECRYETOT, "Next &7UyILTLIEEL,

Setup Replicated Data Set Wizard x
Select or create a valume for Replicator Log ¥ <
Select a volume from existing ones or create a new volume for Replicator Log. %

Select a volume: Create ¥olume

Volumes #l| Layout Size

v The Replicator Leg is a velume which is used as a circular buffer to queue the writes on the Primary host before
they are sent to the Secondary. Each RVG must have a Replicator Log. VWR uses this log to keep track of the
order of writes.

In the asynchronous mode of replication, to prevent the Replicator Log from overflowing, this volume must be
large enough to hold all the writes until they can be sent to the secondary. Use the VRAdvisor tool to estimate
the optimal size of this velume.

< Back Mext > Cancel Help

CCETICANDLEARAROERE@EISEB LEI DT, NBZHERRE “"Create Primary RVG” 27

I LTLIZEW,

I Setup Replicated Data Set Wizard
*% RDS with Primary RVG will be created with following specifications:

Replicated Data Set: rds01
Replicated Volume Group : rvgO1
Primary Host : wveswinQ1
Primary Replicator Log:  srl:srl

Volumes to be replicated : vol01: vol01 (D:)

VERITAS

‘ Click "Create Primary RVG" button to create Primary RVG.

Cancel

Help
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Replicated Data Set DYERA R INT 3L, BIEHVNTLTUT -V 3V DR ELITINEDEHIN
ETDT, "Yes" Z7UvILTLESL,

Setup Replicated Data Set Wizard X

RDS with Primary RVG has been created successfully.

Do you want to add Secondary host to this RDS for replication now?

Mo

LIVT-23avkd/ -k SEDOEHKER /- FeigELET,

Setup Replicated Data Set Wizard x
¥ s
Specify Secondary host for replication %
3

Secondary Host| veswin02

v The Veritas Enterprise Administrator needs to be connected to the specified Secondary host if not already
connected. The connection process will start when you click Mext. Please wait until it completes and then click
Next again.

< Back T Help

SHR/-FOOTMVIEREBNINET DT, AALTEE,

Connect to Veritas Enterprise Administrator X

Enter the connection information:

* veswin02

Username
Password (@

oK Cancel Help

OJ1VIEBRAELINE., RELETYYIVAREI SN, TEROBEABENET, "OK'E7UyILT
<FEEL,

Connection Successful X

| You have successfully created a new connection. You can return to your prior
*  connections by selecting it in the URL bar near the top of the window, or by
selecting it from the "View"->"Connection” menu.

[¥ Show this dialog on next successful connection.
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